
Experiment HH-13: iWire - 12-Lead Electrocardiograms (ECGs)

Equipment Required

PC or Mac Computer

IXTA, USB cable, IXTA power supply

iWire-ECG12 cable

Electrode lead wires

Disposable ECG electrodes (12)

Optional - ECG simulator files

Note: It is suggested that students dress appropriately for these exercises. A button-down shirt will 

make it easier to position the chest leads.

Figure HH-13-S1:  The iWire ECG 12 attached to the iWire 1 port on the front of the TA..
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Electrode Placement

1. The subject should remove all jewelry from his or her neck, wrists, and ankles. Cell phones 

should be removed from pockets.

2. Obtain 12 disposable electrodes. Remove each electrode from its protective plastic sheet and 

apply it to one of the following scrubbed areas on the subject’s body:

• V1 (red) – 4th intercostal space to the 

right of the sternum

• V2 (yellow) – 4th intercostal space to the

left of the sternum

• V3 (green) – Midway between V2 and 

V4 (left side)

• V4 (blue) – 5th intercostal space at the 

midclavicular line (nipple line) left side

• V5 (orange) – 5th intercostal space, 

anterior axillary line

• V6 (purple) – 5th intercostal space, mid-

axillary line

• Right Arm (RA - white) and Left Arm 

(LA - black) limb leads placed on wrist 

or above elbow

• Right Leg (RL - green) and Left Leg 

(LL- red) limb leads placed between 

knee and ankle
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ECG  Alternative Placement for Limb Leads (Recommended for less noise):

• V1 (red) – 4th intercostal space to the right of the sternum

• V2 (yellow) – 4th intercostal space to the left of the sternum

• V3 (green) – Midway between V2 and V4 (left side)

• V4 (blue) – 5th intercostal space at the midclavicular line (nipple line) left side

• V5 (orange) – 5th intercostal space, anterior axillary line

• V6 (purple) – 5th intercostal space, mid-axillary line

• Right Arm (RA - white) and Left Arm (LA - black) limb leads 1-2 inches below the right & left 

clavicle

• Right Leg (RL - green) and Left Leg (LL - red) limb leads placed on lower abdomen near right 

& left iliac crest
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Experiment HH-13: iWire - 12-Lead Electrocardiograms (ECGs)

Exercise 1: ECG from the Chest Leads of a Resting Subject

Aim: To record Resting electrocardiograms from the six chest leads and determine the transition point.

Approximate Time: 15 minutes

Procedure

1. The recording will show ECGs from Leads I, II, Leads III, aVR, aVL, aVF, and the six chest 

leads (V1 through V6). 

2. Make sure the lead wires are attached correctly for recording from Lead I, Lead II, and the other

6 “V” Leads.

3. Type Resting in the Mark box. 

4. After the subject has been sitting quietly for at least one minute, click the Record button on the 

LabScribe Main window. Immediately after starting to record, click mark button to mark the 

recording for a resting ECG of the 8 live leads and 4 calculated leads. 

5. Record for at least 5 minutes to get a good stable recording of the resting ECG. Click the 

AutoScale All button to display the electrocardiogram data in a suitable manner.

Figure HH-13-L1: The recording of a 12-lead electrocardiogram as shown in the Main window of 

LabScribe2. Note heart rate shown on the bottom channel.
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6. Select Save As in the File menu, type a name for the file. Click on the Save button to save the 

data file.

Data Analysis

1. Click the 2-Cursor icon so that two vertical lines appear over the recording window.

2. Scroll through the this section of data and find an area with at least five or six exemplary 

ECG/pulse cycles in succession.

3. Use the Display Time icons to adjust the Display Time of the Main window to show at least five

complete ECG/Pulse cycles on the Main window. Five adjacent ECG/Pulse cycles can also be 

selected by:

• Placing the cursors on either side of a group of four complete ECG/Pulse cycles.

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the 

segment with the five selected ECG/Pulse cycles to the width of the Main window.

5. Data can be collected from the Main window or the Analysis window.  If you choose to use the 

Analysis window, click on the Analysis window icon in the toolbar.

6. The mathematical functions, V2-V1, T2-T1 and Mean should appear on screen. The values for 

V2-V1, T2-T1 and Mean on each channel are seen in the table across the top margin of each 

channel, or to the right of each graph.

Figure HH-13-L2: The LabScribe2 toolbar.   

7. Use the mouse to click and drag the cursors across the section of data for Resting ECG to 

measure:

• the amplitude, V2-V1, of five adjacent R waves in the ECG from Lead I, Lead II and the

V1-V6 chest leads. The amplitude is measured from the onset of the Q wave to the peak 

of R wave.  Data from Lead III, aVR, aVL and aVF may also be collected.

• the amplitude, V2-V1, of five adjacent P waves in the ECG from the same section of 

data. The amplitude is measured from the baseline, between the T and P waves, to the 

peak of P wave. Data from Lead III, aVR, aVL and aVF may also be collected.
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• the amplitude, V2-V1, of five adjacent T waves in the ECG from the same section of 

data. The amplitude is measured from the baseline to the peak of T wave. Data from 

Lead III, aVR, aVL and aVF may also be collected.

8. The functions in the channel pull-down menus of the Analysis window can also be used to enter

the names and values of the parameters from the recording to the Journal. To use these 

functions:

• Place the cursors at the locations used to measure the amplitudes of the waves in the 

ECG cycle.

• Transfer the name of the mathematical functions used to determine the amplitudes to the 

Journal using the Add Title to Journal function in the Tools pull-down menu.

• Transfer the values for the amplitudes to the Journal using the Add Ch. Data to Journal 

function in the Tools pull-down menu.

• To transfer the image to the Journal, use the Add Image to Journal function in the Tools 

pull-down menu.

9. Once the cursors are placed in the correct positions for determining the amplitudes, V2-V1, the 

values of the amplitudes can be recorded in the on-line notebook of LabScribe by typing their 

names and values directly into the Journal, or on a separate data table.

Figure HH-13-L3: In the Analysis window, the electrocardiogram showing the cursors in position to 

measure the amplitude (V2-V1) of a T-wave. Note: some chest leads not shown.
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10. Click the Main Window icon from the LabScribe toolbar to go back to the main recording 

window.

11. Calculate the average amplitudes of the P, R, and T waves for each lead. Enter these values into 

Table 1.

12. Find the transition point of the subject by examining the recordings from the six chest leads. 

Find the lead where the R wave is equal in magnitude to the S wave but in the opposite 

direction.

Questions

1. From which leads are inverted P and T waves recorded? From which leads are inverted R waves

recorded?

2. From which lead is the amplitude of the R wave equal, and opposite in direction, to the S wave?

3. Which lead is over the anterior edge of the interventricular septum?

Table HH-13-L1:The average amplitudes (in millivolts) for each of the waves recorded from each

lead.

Average Amplitudes P Wave R Wave T Wave

Lead I

Lead II

V1

V2

V3

V4

V5

V6

Lead III

aVR

aVL

aVF
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Exercise 2: ECG from the Chest Leads of Other Students 

Aim: To record electrocardiograms from the six chest leads of other subjects and determine their 

transition points.

Approximate Time: 15 minutes per subject

Procedure

1. Disconnect the leads from the first volunteer’s electrodes and place them on the electrodes of a 

second student. 

2. Follow the procedures in Exercise 1 to record electrocardiograms from the six chest leads of the

new subject.

3. Repeat the procedures until all subjects have recorded their chest lead electrocardiograms.

Data Analysis

Make the same measurements as done in Exercise 1.

Questions

1. Do the R waves, from the same lead position, go in the same direction for all subjects? The P 

waves? The T waves? 

2. What would cause the same type of wave from the same lead to go in the opposite direction in 

different subjects?

3. Do all subjects have the same transition point? Which leads were found to be the transition 

points in the subjects tested? What could cause a difference in the transition points?

Exercise 3: ECG Hypothesis, Data Collection and Analysis

Aim: To have students design their own experiment based on their knowledge of what may alter a 

person’s ECG. 

Approximate Time: 20 minutes or more based on the group’s hypothesis

Procedure

1. Formulate a hypothesis where you would expect to see changes in the subject’s ECG.

2. Make sure to present this hypothesis to your instructor and get permission to do the experiment 

prior to continuing with your experiment.

3. Follow the procedures in Exercise 1 to record an ECG from your subject and collect data during

the testing of your hypothesis.  Timing changes will be the most significant observations.
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Data Analysis

1. Make the same measurements as done in Exercise 1.

2. Create a data table in which to record your data.

3. Compare your data to the data recorded in Exercise 1.

Questions

1. What happened to the subject’s ECG during the testing of your hypothesis? 

2. What parameters changed? How did they change?

3. Did your hypothesis get the expected results? Why or why not?

Exercise 4: OPTIONAL - Using the 12-Lead ECG Simulator

Aim: To record simulated electrocardiograms showing a variety of abnormal rhythms and to be able to 

understand the differences between these and normal sinus rhythm.

Approximate Time: 10 minutes per rhythm

ECG Cable Setup

1. Plug the snap leads from the iWire-ECG12 to the appropriate snaps on the ECG-SIM-1200 - 

ECG Simulator.

• The four limb leads will be connected on the right side of the simulator - RA, RL, LA 

and LL.

• The six chest leads will be connected to the left side of the simulator - V1, V2, V3, V4, 

V5, and V6.

2. Make sure the snaps are securely fastened to the simulator.

Procedure

1. Retrieve the ECG-SIM-1200-12Lead ECG Simulator and check to make sure the batteries have 

been installed properly.

2. Turn the unit on by pressing the On/Off button on the front of the unit. The light will glow on 

one of the selected rhythms.

3. Click NSR to select normal sinus rhythm.

4. Click the Record button to start the recording of normal sinus rhythm. Record for a minimum of

30 seconds to get a good recording of a normal cardiac rhythm.

5. Click Stop to halt the recording. Click Save to save your data.
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Figure HH-13-L4: ECG-SIM-1200

6. Choose another rhythm to record by pressing the button associated with the cardiac rhythm you 

wish to examine.

• As examples:

• Select 1st RBBB for 1st right bundle branch block

• Select AFIB for atrial fibrillation

• Select S Tach Ant ST+ for sinus tachycardia 

Note: Any rhythm can be selected by pressing the button associated with the cardiac rhythm you wish 

to view.

7. Repeat steps 4-6 to continue recording a variety of cardiac rhythms. It is suggested that at least 

5 different rhythms are recorded to gain an understanding of the variety of cardiac arrhythmias 

that may present themselves in a clinical situations.

Data Analysis

1. Make the same measurements as done in Exercise 1 with the addition of measuring the duration

of each wave form.

2. In the Analysis window, click add function to add the General T2-T1 function for determining 

the duration of each wave.

• Place the cursors on either side of the P-wave to find the Pwave duration.

• Place one cursor on the Q-wave and the second cursor on the S-wave to determine the 

duration of the QRS complex.
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• Place the cursors on either side of the T-wave to find the Twave duration.

3. Create a data table in which to record your data.

4. Compare your data to the data recorded in Exercise 1 or to the normal sinus rhythm recorded 

using the ECG-SIM-1200 simulator.

Figure HH-13-L5:  Normal Sinus Rhythm recorded using the ECG simulator.

Questions

1. Based on normal sinus rhythm - compare the 5 different arrhythmias recorded.

• compare the P-wave amplitude and duration and discuss how and why the values are 

different from a ‘normal’ P-wave.

• compare the T-wave amplitude and duration and discuss how and why the values are 

different from a ‘normal’ T-wave.

• compare the QRS duration and discuss any differences.

2. Note any physiological factors that may cause the arrhythmias that you looked at.

3. Discuss the medical interventions that are available to correct the arrhythmias. Include both 

medical and surgical options.
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